
ome 3D software – even the free 

versions – can take so long to 

learn that it’s not worth the has-

sle. True to Google’s tag line, SketchUp 

[1] is “3D for everyone” and can be 

downloaded for free [2]. SketchUp was 

developed by @Last Software, Inc. in the 

early 2000s and acquired by Google in 

2006. Current versions support Windows 

XP, Windows Vista, and Mac OS X. A 

Linux version is not available, but some 

Linux users have succeeded with run-

ning SketchUp on Wine [3].

SketchUp approaches the often diffi-

cult concept of three-dimensional visual-

ization differently than many of the 

heavy hitters in the 3D arena. Rather 

than relying on the creation of solid 

primitives, such as spheres, boxes, and 

pyramids, followed by repeated applica-

tions of Boolean add, subtract, and inter-

sect operations, SketchUp simplifies 

things by letting you draw simple 2D 

shapes like you would on a sheet of 

paper, and then extruding them into the 

third dimension. Add to that a handful 

of basic tools that have multiple uses, 

and you have a lean and efficient tool for 

building models of just about anything 

you can imagine.

A simple demonstration of how to use 

the tools available in SketchUp would be 

pretty boring, especially when there are 

countless online video tutorials that al-

ready do that quite well. 

To introduce SketchUp, I’ll take you 

through an example by creating my idea 

of how Googlebot – a software “robot” 

that crawls web pages looking for rele-

vant content to carry back to Google’s 

search indexes – might look in the flesh 

(Figure 1).

SketchUp novices should be able to 

follow along without previous experi-

ence, but a little working knowledge of 

the program’s basics will make it easier 

to follow. Navigating your way around a 

3D model involves some practice with 

tools such as Orbit, Pan, and Look 

Around. 

Google’s tutorials for beginners are 

available online [4], through the Help 

menu, or via the introductory launch 

window.

When you first open SketchUp, an intro-

ductory dialog box appears (Figure 2). 

Clicking on the Choose Template button 

simultaneously collapses the Learn win-

dow and expands the Template window, 

revealing a list of predefined work envi-

ronments for you to select. To work with 

feet and inches, select the Simple Tem-

plate at the top of the list, which is the 

one I’ll use for this article. Metric op-

tions are also available.

After selecting your template, click on 

the Start Using SketchUp button located 

in the lower right-hand corner. The stan-

dard user interface appears (Figure 3), 

complete with a set of three global axes: 
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a vertical blue axis and two axes on the 

ground plane (one red and one green). 

SketchUp also plants a human figure, 

which you can delete with a click, on 

the ground plane near the origin of your 

design world.

SketchUp presents you with a stan-

dard set of default tools on the left-hand 

side of the work space. If you don’t see 

them, click on the Large Tool Set option 

under View | Toolbars. Also, you might 

want to select Measurements from the 

same menu; this feature appears in the 

lower left-hand corner and displays a 

small window that reports important 

data that will help you place objects ac-

curately.

For this article, I took the screenshots 

with the shaded view option (View | 

Face Style | Shaded). To keep SketchUp 

running smoothly and quickly, consider 

using the simpler Hidden Line option 

while constructing your model (View | 

Face Style | Hidden Line); the less 

SketchUp needs to render, the faster it 

will run.

One of the most powerful functions of 

SketchUp is 3D Warehouse, a searchable 

online kit-of-parts built by the SketchUp 

user community and free for use in your 

model. Filled with a mind-boggling array 

of downloadable 3D models, 3D Ware-

house provides a browser-based inter-

face with easy access to models of any-

thing you can imagine, such as simple 

household objects, classic automobiles, 

insects, people, and even models of the 

Roman Colosseum. Yes, the Colosseum.

If you choose to build a 

3D model of a building – 

your own house, for exam-

ple – there’s even an inter-

face to Google Earth that al-

lows you to upload your 

model and drop it right on 

the street where you live.

3D Warehouse is home to 

the first object used to build 

my sample Googlebot: a 

five-spoke wheel and tire as-

sembly. To save time, I’ve 

already built this compo-

nent and uploaded it to the 

3D Warehouse for your use. 

To insert the wheel assem-

bly into your model, go to 

File | 3D Warehouse | Get 

Models. A simple browser 

window appears, showing a 

search bar and a random sample of mod-

els in the warehouse. 

Typing in Wheel and Tire for Googlebot 

into the search bar should produce an 

icon representing the model you want. 

After you click on the image, the 

browser displays a page that will allow 

you to download the model directly into 

your file (Figure 4).

Next, click on Download Model. The 

insertion point for this model is at the 

bottom of the tire along its centerline. 

When you click on the origin of your 

work space, the assembly drops into 

place directly onto the ground plane.

The individual surfaces that comprise 

this assembly have been grouped to-

gether into one object. As you create 
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 individual subassemblies like these, it’s 

good practice to collect them into groups 

(Edit | Make Group), which helps 

SketchUp run faster and allows easy ma-

nipulation of complex geometry. To edit 

groups without expanding them, just 

double-click on the group.

Cyberspace can be a slippery place at 

times, so you’ll want to give the Google-

bot a little extra traction. To fatten up the 

front wheel assembly, first select it, then 

click on the Scale tool in the Large Tool 

Set on the left-hand side. If you’re using 

a PC, hold down the Ctrl key and click 

on the grip box at the center of the 

wheel. SketchUp notifies you that you 

have selected “Red scale about center.” 

Next, drag the grip in the direction of the 

red (horizontal) axis until the numbers 

in the Measurements box reads 1.50. 

When you release the mouse button, 

your new wheel is fatter by 50 percent. 

Holding the Ctrl key forces the scaling 

to be fixed about the center of the object, 

which keeps the wheel centered on the 

blue-green plane (Figure 5). Without 

using this key, the base point for scaling 

defaults to the grip located directly op-

posite the one you selected, which 

means that the center of the fatter wheel 

would end up being pulled slightly to 

one side.

To move the wheel exactly where you 

want it, use the Move tool, which is lo-

cated above the Scale tool. As you might 

expect, the Move tool moves objects 

from any origination point along a 

straight line to a specified destination 

point. For our example, click on the 

Move tool, click anywhere on the wheel, 

and then drag it along the red axis until 

the Measurements bar reads 1’-8” and 

release the mouse button. 

Alternatively, you could simply type in 

the distance 1’-8” and then hit Enter 

after you’ve established the correct di-

rection, and the wheel assembly will 

land in the right place. 

In either case, SketchUp will draw a 

dynamic dashed line between your origi-

nation point and your cursor until 

you’ve located your destination point. 

As you move your object, that dashed 

line will change to the color of one of the 

three global axes when it is parallel to it. 

If you hold down the Shift key when 

you’ve found your alignment, the 

dashed line is locked in that direction.

To make a second front wheel, use the 

same Move tool, but to create a copy of 

the object rather than just moving it, 

hold down the Ctrl key as you drag the 

wheel along the red axis. SketchUp 

leaves your wheel assembly in its origi-

nal location while it waits for you to 

specify where you want the duplicate. 

Check the Measurements window for a 

distance of 3’-4” and then release the 

mouse button. To keep things tidy, cre-

ate the duplicate wheel on the opposite 

side of the blue-green plane. Use the 

Move tool with Ctrl to locate the single 

rear wheel (centered between the two 

front wheels and located 3’-6” behind 

them).

To give the Googlebot some attitude, 

you can scale the rear wheel up by an 

additional factor of 1.50, but this time, 

apply the scaling to all three dimensions 

of the wheel, not just its width. To do 

this, use the Scale tool as before, but 

grab one of the grips located on a corner 

of the blue bounding box instead of the 

grip located at the center of the vertical 

face. 

Because this scaling process increases 

the size of the wheel in all directions 

from the center of the wheel, the bottom 

of the tire moves slightly below the 

ground plane. With one more applica-

tion of the Move tool, you can raise the 

wheel assembly upward along the blue 

axis until its contact point is back on the 

green axis.

To make axles for the front wheels, 

use the Circle tool to make a 1.5” radius 

(3” diameter) circle centered on the in-

side face of one of the wheels. With the 

Circle tool, SketchUp turns your cursor 

into the shape of a protractor of varying 

colors depending on the rotation axis to 

which it’s snapping. You might need to 

move your cursor around the screen 

until SketchUp offers you the orientation 

of the circle plane you want. Once 

you’ve found it, hold the Shift key to 

lock that orientation, and then click on 

the point where you want the center of 

the circle to be drawn. Pull your cursor 

away from the center until the Measure-

ments bar reads 1.5, or simply type in 

1.5 and press Return. To tell SketchUp 

that you want it to snap to the wheel’s 

center, hover around the edge of the 

outer circle before your first click.

Next, select the Push/ Pull tool (sixth 

tool down from the top of the right-hand 

column), click and release on the circle 
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you just created, and drag your cursor 

along the red axis until any point on the 

inside face of the opposite wheel hub is 

highlighted. Then click on that point and 

you’ve got a sturdy axle (Figure 6).

Before you begin building the body, 

you’ll want to collect everything you’ve 

created so far into a group. This will pro-

tect your wheels, tires, and axles by pre-

venting any future creations from cutting 

into or sticking to them. Select all the 

parts in your model, right click, and se-

lect Make Group.

In the previous section, I explained how 

to use the Push/ Pull tool to construct the 

front axle. Any time you see a flat sur-

face in your model, you can use Push/ 

Pull to extrude it along a perpendicular 

direction, much like clay squeezing its 

way through an oddly shaped hole. 

SketchUp will not allow you to push or 

pull on a curved surface, but that does 

not reduce the tool’s value.

To build the body of the Googlebot, I’ll 

use a technique that’s applicable to proj-

ects of all kinds. First, draw a profile 

view of the shape you want onto a rect-

angular surface, divide it into sub-re-

gions with various drawing tools, and 

then use the Push/ Pull tool to extrude 

the shapes into 3D. To apply this to the 

Googlebot, use the Line tool or the Rect-

angle tool to make a large drawing sur-

face directly onto the blue-green plane. 

If you choose to use the Rectangle 

tool, it might be easier to create the ge-

ometry on the red-green plane, and then 

use the Rotate tool to flip it vertically. 

Again, think of this surface as a big piece 

of drawing paper, so be sure it’s large 

enough to encompass your planned de-

sign (Figure 7).

At this point, you might find it useful 

to work on your body profile from a di-

rect side view. To do so, choose Camera 

| Parallel Projection to remove perspec-

tive, and then choose Camera | Standard 

Views | Right to get a right-side view. 

From here, you can easily use the Line, 

Arc, Circle, or Rectangle tool to draw the 

body profile any way you like. To ensure 

that your line work snaps directly to the 

rectangle and not to points on a wheel, 

hover over an empty space on the rect-

angle until SketchUp reports “On Face,” 

and then hold down the shift key to lock 

your subsequent clicks onto the plane.

Each time you draw onto this plane, 

SketchUp automatically cuts through the 

hosting rectangle like a knife and creates 

separate sub-regions that can be oper-

ated on independently. So, you can se-

lect the outer waste region of your large 

rectangle and then delete it. If you return 

to a perspective oblique view using the 

Camera menu and the Orbit tool, you 

can then use the Push/ Pull tool to ex-

trude the faces of the body panels to 

whatever thickness you like. You can 

also use the Move tool on individual 

lines and points within your sub-regions 

to make bulges in the body panels.

At this point, you have one half of the 

full body. To create the other half, you’ll 

use the Scale tool as before, but this time 

with a trick. SketchUp does not have a 

mirror tool, but if you realize that scal-

ing an object along an axis using a nega-

tive scale factor will create a reflected 

image about a plane that is normal to 

that axis, you have a nifty solution to the 

problem.

To do this, first group the body pieces 

you’ve created so far by selecting them, 

right clicking on your mouse, and select-

ing Make Group. Next, make a copy of 

this group elsewhere in the model space. 

Select this new group, click on the Scale 

tool, and grab the center grip on the 

large rectangular face. Then drag the 

grip toward the opposite side of the body 

centerline until the Measurements bar 

indicates “Red Scale -1.00,” and click to 

finish the operation.

Next, move your mirrored duplicate 

body half adjacent to the original. If you 

want, you can now explode each of the 

two groups that form your full body by 

using Edit | Component | Explode, and 

use the Eraser tool to remove the lines 

along the seam between the two halves. 

Be careful: SketchUp might need some 

of those lines to define surfaces, so be 

prepared to undo an erased line if a sur-

face disappears with a deleted line. If 

this happens, you might just have to live 

with the extra lines. Then reselect all of 

the body entities and create a new group 

(Figure 8).

A proper Googlebot wouldn’t be able to 

scan web pages very well if it didn’t 

have some pretty powerful eyes. To that 

end, I chose a pair of Nikon binoculars 
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modeled by a SketchUp user who 

goes by the name Birdman (his 

collection of on-line models in-

cludes dozens of highly detailed 

birds). To insert these binoculars 

into the model, enter the 3D 

Warehouse through File | 3D 

Warehouse | Get Models and type 

“Nikon 10x42 Monarch” into the 

search bar. Then click on Down-

load Model and insert it any-

where in your work space.

The binoculars will enter your 

model as a “component” rather 

than a “group.” Components are 

much like groups in SketchUp, 

except that they also have asso-

ciative properties. That is, 

changes to any one component 

will propagate to all its copies. 

Groups, on the other hand, are stand-

alone entities that have no linked associ-

ation with their duplicates.

Let’s not make any copies of the bin-

oculars component, but let’s rotate the 

binoculars around the red axis so that 

they’re looking forward and slightly 

downward. When selected, components 

will display a blue bounding box that en-

compasses all of the contained objects. 

SketchUp also displays small red 

crosshairs on each face of the blue 

bounding box. Clicking on one of these 

crosshairs will automatically activate the 

rotate function, allowing you to orient 

your component about an axis normal to 

the associated face (Figure 9).

Before placing the binoculars onto the 

body, you’ll need a turret for it to sit on, 

so draw a circle on the top of the body 

and use Push/ Pull to extrude it up verti-

cally about 12 inches.

You’ll be moving the binocular compo-

nent from a point on its underside to a 

point on the top of the turret. In cases 

like this, there is no hidden-line view 

that gives you clear access to both 

points. To solve this problem, switch to 

wireframe mode (View | Face Style | 

Wireframe). If you’re not accustomed to 

3D modeling on a computer, you’ll find 

this view very confusing at first, but 

there are times when there is no other 

way to gain access to the points you’ll 

need.

At this point, all the primary pieces of 

the Googlebot are assembled. As with 

most projects, the amount of detail you 

could apply is limitless. For example, 

there aren’t any headlights to illuminate 

the depths of a code-bloated web page. 

By now, you’ve seen all the SketchUp 

tools and tricks necessary to build a ver-

sion of the Googlebot that solves these 

problems.

SketchUp gives you several ways to en-

hance the appearance of your models by 

allowing you to apply various material 

textures, colors, even shade and shad-

ows. To apply textures to surfaces, first 

activate the Shaded with Textures option 

under the View menu, and then select 

the Paint Bucket tool. The Materials dia-

log box appears and shows all of the tex-

tures that come installed with SketchUp. 

From the drop-down menu, I chose 

Metals, which then presented 10 options. 

For my Googlebot, I chose Metal_Steel_

Textured_White to give the heavy-duty 

look of diamond-plate sheet steel, and I 

applied it to the front fenders and grill. 

The drop-down menu also lists Colors-

Named, which provides 137 colors to 

choose from; I applied 0103_Blue, 0098_

Dodgerblue, and a variety of dark and 

medium grays to the remaining surfaces 

of the body.

The Materials dialog box was also de-

signed to accept downloads of other pre-

defined material textures, but at the time 

of this writing, Google had not yet made 

that option available from their Bonus 

Pack download center [5]. 

Using the Edit tab on the Paint Bucket 

dialog box, you can still add user-created 

textures. The “+” icon in the upper 

right-hand corner leads 

you to the Create Material 

window from which you 

can load an image file 

that was created using 

just about any third-party 

image-editing software. 

Using the 3D Text tool, 

you can also add 3D text 

to your model.

Google makes no claim 

that their free software 

will provide photo-realis-

tic images of your models, 

but they’ve given 

SketchUp a variety of ex-

port formats that are 

readable by many of the 

powerful rendering tools 

available on the market. 

Still, SketchUp provides surprisingly ac-

curate shading and shadowing. To add 

this final touch of realism to your model, 

select the Shadows option from the View 

menu. SketchUp’s performance will slow 

down noticeably in this mode, so it’s 

best to reserve this option for last. 

Using the Window menu, you can ad-

just the sun angle. Select Window | 

Model Info | Location and choose a city 

from the drop-down menu. Adjust the 

north direction numerically by entering 

an angle measured from the green axis, 

or graphically using the Select option. 

Next, open the Window | Shadows dia-

log box to define the date, the time of 

day, even the intensity of the incident 

light and resulting shadows.

SketchUp is a practical, powerful, and 

fun tool for tapping into your creativity 

without wasting your valuable time or 

money. Happy modeling!  p
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